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ABSTRACT

Time management plays a crucial role in construction project management because delays in project
completion can lead to increased costs, client dissatisfaction, and even financial losses. Therefore, the success
of a construction project depends on.effective time planning and control. Therefore, an appropriate time
management method is needed. One of the most commonly used methods in project time management is the
Critical Path Method, as it allows project managers to determine critical activities that will determine the
project duration. By utilizing an arrow diagram to determine the critical path, this method is known as the
critical path method. This study aims to effectively plan and schedule work analysis using the Critical Path
Method implemented in Microsoft Project. Furthermore, this study will analyze critical activities to minimize
the risk of future delays. The results of the scheduling analysis of the Faculty of Teacher Training and
Education Building construction project at Siliwangi University using the Critical Path Method and Microsoft
Project software indicate that the project scheduling duration using the CPM method is 181 working days,
compared to 245 working days. The project started on March 6, 2024, and ended on November 11, 2024. This
means the project was completed 64 days earlier than the contract execution date. With 9 main activities that
are on the critical path, namely activities A-C-D-E-G-K-M-Q and R. These activities have a slack value = 0,
so they have no tolerance for delays and require strict supervision.

Keywords: Time,scheduling, CPM, Critical path

I. PENDAHULUAN proyek  kontruksi  bergantung  pada
. o d dali kt

Proyek kontruksi merupakan salah satu jenis ggligcf:anaan an pengefidaiian wakit yang

proyek yang memerlukan perencanaan dan )

pengendalian waktu yang cermat. Dalam Namun  demikian,  perencanaan  dan

proses pelaksanaanya, terdapat tiga kendala
utama yang harus diperhatikan, yaitu: (a)
kendala kualitas, yang harus sesuai dengan
spesifikasi yang telah ditetapkan; (b) kendala
waktu, yang mengharuskan pelaksanaan
sesuai dengan jadwal yang telah ditentukan;
dan (c) kendala biaya, yang berarti tidak boleh
melebihi anggaran yang direncanakan. Oleh
karena itu, penting untuk memastikan bahwa
ketiga kendala ini dapat dipenuhi secara
bersamaan (Wulfram I,Ervianto, 2023).

Manajemen waktu memiliki peran krusial
dalam manajemen proyek kontruksi karena
keterlambatan penyelesaian proyek dapat
menyebabkan lebih  banyak  biaya,
ketidakpuasan klien, dan bahkan kerugian
finansial. Dengan demikian, keberhasilan

pengendalian waktu proyek kontruksi sering
kali dihadapkan pada berbagai masalah,
seperti  ketidakpastian kondisi lapangan,
perubahan desain, ketersediaan material, dan
cuaca. Tanpa bantuan yang tepat, manajer
proyek dapat kesulitan memantau kemajuan
proyek, menemukan masalah yang mungkin
terjadi, dan melakukan perbaikan segera.
Untuk  mengatasi  tantangan  tersebut,
dibutuhkan strategi dan alat bantu yang dapat
mendukung  proses  pemantauan  dan
penjadwalan proyek secara sistematis dan
akurat. Salah satu metode yang paling umum
digunakan dalam manajemen waktu proyek
adalah Critical Path Method (CPM) karena
memungkinkan manajer proyek untuk
menentukan aktivitas penting yang akan
menentukan  durasi  proyek.  Dengan
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memanfaatkan diagram anak panah untuk
menentukan lintasan kritis, metode ini dikenal
sebagai metode lintasan kritis (Soeharto, 197).
Namun, menerapkan metode CPM secara
manual dapat memakan waktu dan rentan
terhadap kesalahan.

Untuk mengoptimalkan penggunaan metode
CPM, diperlukan bantuan perangkat lunak
seperti  Microsoft ~ Project. = Menurut
(Asmarizan, 2021) Microfoft Project adalah
perangkat lunak komputer yang membantu
tim proyek dalam mengelola aktivitas dan
rencana, serta melacak kemajuan, alokasi
sumber daya, dan penganggaran. Fiturnya,
seperti gantt chart, analisis jalur kritis, dan
pembagian sumber daya, memungkinkan
manajer proyek untuk membuat jadwal yang
akurat, memantau kemajuan proyek, dan
menemukan area  yang - memerlukan
perbaikan. Diharapkan bahwa penggunaan
alat ini akan meningkatkan efisiensi dan
akurasi dalam mengelola waktu proyek
kontruksi.

Penelitian ini akan mengkaji Proyek
Pembangunan Gedung Fakultas Keguruan
dan Ilmu Pendidikan Universitas Siliwangi,
yang merupakan proyek yang cukup
kompleks dengan banyak aktivitas yang saling
bergantung, dalam pelaksanaannya, proyek
ini  mengalami  keterlambatan  pada
pemasangan profil baja yang disebabkan
beberapa faktor seperti pekerjaan berlangsung
di lingkungan yang sempit dan padat
pengunjung, sehingga sulit untuk menyimpan
material dalam jumlah besar. Selain itu,
material yang dibutuhkan harus menempuh
perjalanan jauh. Cuaca yang buruk juga kerap
menggangu proses pengerjaan. Penelitian ini
bertujuan  untuk  merencanakan  dan
menjadwalkan analisis pekerjaan secara
efektif dengan menggunakan metode CPM
yang diimplementasikan dalam Microsoft
Project. Selain itu, penelitian ini akan
menganalisis aktivitas  kritis  serta
memberikan rekomendasi untuk
meminimalkan risiko keterlambatan di masa
mendatang.

Dengan demikian, penelitian ini diharapkan
dapat memberikan kontribusi dalam bentuk
pedoman praktis bagi yang membutuhkan
dalam menggunakan metode CPM dan

Microsoft Project secara optimal untuk
meningkatkan efisiensi dan efektivitas
pengelolaan waktu proyek kontruksi.

II. METODOLOGI PENELITIAN

Penelitian ini  memanfaatkan  metode
kuantitatif , dimana penelitian ini mengambil
data dilapangan berupa data sekunder dan data
primer. Selain itu, penelitian ini juga dibantu
oleh aplikasi Microsoft Project dan metode
CPM (Critical Path Method) yang digunakan
untuk menyusun dan menganalisis jadwal
proyek secara sistematis, sehingga dapat
membantu dalam menentukan jalur krisis dan
efisiensi waktu pelaksanaan kegiatan.

- Teknik Pengumpulan Data

1. Data Perimer

Data primer adalah data yang diperoleh
langsung dari sumber pertama atau objek
penelitian melalui pengumpulan data di
lapangan.

a. Dokumentasi

2. Data Sekunder

Data sekunder adalah data yang telah
dikumpulkan dan diolah oleh pihak lain,
bukan langsung peneliti dari sumber pertama.
Data ini biasanya sudah tersedia dalam
bentuk dokumen, laporan, arsip, atau
publikasi resmi.

a. Time Schedule

b. RAB

c. Laporan Mingguan

d. Laporan Tenaga Kerja

Adapun tahapan pada penelitian ini, yaitu
sebagai berikut :
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Gambar 1. Flow Chart

III. HASIL DAN PEMBAHASAN
3.1. Data Proyek

Data proyek pembangunan gedung fakultas
keguruan dan ilmu pendidikan universitas
siliwangi adalah sebagai beriikut :

Nama Bangunan Pembangunan
Gedung FKIP
Universitas
Siliwangi

Lokasi JI. Siliwangi No 24
Kota Tasikmalaya

Fungsi Bangunan Fasilitas
Pendidikan

Tanggal Kontrak 06 Maret 2025

Akhir Kontrak 06 November 2025

Nilai Kontrak Rp. 20.592.626.336
(Termasuk PPN
dan PPh)

3.2. Uraian pekerjaan dan durasi proyek

Durasi pelaksanaan proyek Pembangunan
Gedung Fakultas Keguruan dan Ilmu
Pendidikan Universitas Siliwangi adalah 245
(Dua Ratus Empat Puluh Lima) hari kalender
kerja, Sistem kerja proyek ini berlangsung
selama 7 hari dalam seminggu, dari hari senin
hingga minggu, dengan durasi 8 jam per hari

Pekerjaan proyek dibagi ke dalam 18 kategori
utama, yang meliputi pekerjaan persiapan,
struktur, arsitektur, sistem utilitas (plumbing,
elektrikal, fire alarm, dll), hingga system
jaringan informasi seperti CCTV dan LAN.
Setiap pekerjaan memiliki durasi rencana dan
realisasi (aktual) yang telah diamati selama
pelaksanaan  proyek. Tabel 1 berikut
menyajikan daftar uraian pekerjaan beserta
durasi menurut rencana dan aktual:

Tabel 1. Daftar uraian pekerjaan beserta

durasi
. . Durasi Durasi
Uraian Pekerjaan Aktual Rinca
1. Pekerjaan Persiapan 14 12
2 SMKK 9 8
3 Pek. Sub Struktur 24 22
4  Pek. Struktur Lantai 1 22 21
5  Pek. Struktur Lantai 2 26 21
6  Pek. Pasangan 23 22
7 - Pek. Struktur Lantai 3 26 22
8  Pek. Plumbing 6 6
9  Pek. Air bersih
7 7

gedung
10 Pek. Struktur lantai 19 16

dak
11 Pek. Atap dan plafon 16 16
12 Pek. System 5 5

elektrikal
13 Pek. Pelapis lantai

dan dinding 22 21
14 Pek. System fire

5 5

alarm
15 Pek. Instalasi hydran 7 5
16 Pek. System tata 6 5

suara
17 Pek. Pengecatan 25 25
18 Pek. Data lan, acces 6 6

poind & CCTV

Sumber : Hasil Penelitian (2025)

Berikut untuk wuraian perhitungan durasi
rencana adalah :

- Pekerjaan Persiapan : Volume = 242.00
_ 242.00 x 0.300
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Durasi yang dipakai yang paling tinggi =
12 hari
- Pengadaan dan persiapan  aspek
keselamatan : volume = 60.00
Durasi = 8 hari

Pekerja = R = 6.00
60.00 x 0.250

Tukang =222 - 800

Kepala tukang = w = 6.00

- Pekerjaan Sub struktur :Volume = 509.36
Durasi =22 hari

_509.36 x0.600

Pekerja ” =22.00
Tukang _ 509.369x 0200 - _ |, 4,
Kepala tukang = Sog'ilxm =5.09
Mandor _50936x0015 _ o,

1

- Pekerjaan Struktur Lantail:Volume= 450

Durasi =21
Pekerja = ——450'051); 22 -1039
Tukang Bes = Msxomo =21.00
Kepala Tukang = w =4.50
Mandor _45005x0015  _ .

1

Dari  hasil perhitungan sebagian besar
aktivitas mengalami penambahan durasi
dibandingkan dengan rencana semula.

3.3. Identifikasi
Kegiatan
Dalam suatu proyek kontruksi, langkah
penting dalam perencanaan penjadwalan
adalan menguraikan pekerjaan ke dalam
komponen-komponen kegiatan yang lebih
kecil. Setiap kegiatan ini diberi simbol atau
kode agar memudahkan analisis penjadwalan,
terutama saat menyusun network diagram
(diagram jaringan kerja) dengan metode

CPM.

Proyek Pembangunan Gedung Fakultas
Keguruan dan Ilmu Pendidikan Universitas
Siliwangi diuraikan ke dalam 18 komponen

Hubungan Antar

kegiatan utama. Setiap kegiatan mewakili satu
kelompok pekerjaan kontruksi yang memiliki
fungsi dan waktu pelaksanaan masing-
masing. Penentuan simbol atau huruf pada
masing-masing kegiatan bertujuan untuk
menyederhanakan representasi visual dalam
diagram  jaringan dan mempermudah
pelacakan lintasan kritis
Tabel 2. Hubungan antar kegiatan

Sim Pen Lani
Uraian Pekerjaan ! dah J
bol utan
ulu
1 Pequj aan A ) C
Persiapan
2  SMKK B - C
3 Pek. Sub Struktur C D
4 Il’ek. Struktur lantai D C EF
5  Pek. Struktur
Lantai 2 E D G
6 Pek. Pasangan F D H,I
7  Pek. Struktur
Lantai 3 G E IK
8 Pek. Plumbing H F L
9  Pek. Air bersih I F L
gedung
10 Pek. Struktur lantai J G M
dak
11 Pek. Atap dan K G M
plafon
12 Pek. Sistem L I N,O,
elektrikal P
13 Pek. Pelapis lantai
dan dinding M J Q
14 Pek. Sistem fire N L Q
alarm
15 Pek. Instalasi
hydran 0 L Q
16 Pek. Sistem tata P L Q
suara
17 Pek. Pengecatan Q R
18 Pek data lain, acces R Q )
point & CCTV

Sumber : Hasil Penelitian (2025)

Dari tabel di atas dapat dilihat bahwa proyek
ini memiliki struktur logika yang kompleks, di
mana satu kegiatan bisa memiliki lebih dari
satu pendahulu atau lanjutan. Sebagai contoh,
pekerjaan sub struktur (C) hanya bias dimulai
setelah pekerjaan persiapan (A) dan aspek
keselamatan (B) selesaai.

3.4.Penjadwalan proyek Critical Path
Method (CPM)
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CPM terdapat dua cara untuk mengetahui
jalur kritis dengan menghitung dua waktu
awal dan akhir untuk setiap kegiatan yaitu,
perhitungan maju dimulai pada titik mulai
(start) dan selesai pada titik akhir (finish), dan
memiliki komponen ES (waktu tercepat
memulai suatu kegiatan) dan EF (waktu
tercepat untuk menyelesaikan suatu kegiatan).
3.4.1 Analisa Hitungan Maju (Fordward Pass)
Proses perhitungan dimulai dari waktu nol di
Awal proyek dan dilanjutkan ke setiap
aktivitas berikutnya mengikuti urutan logis
yang telah ditentukan pada jaringan kerja.
Rumus dasar yang digunakan untuk
menghitung waktu penyelesaian paling awal
adalah :

EF(i-j))=ES({i-j)+D

Tabel 3 Hasil analisa hitung maju

25 150 175
18 19 6 175 181

. Paling

Kegiatan Kegiata Waktu Awal

; i n (Hari) Mul Sele

ai sai
1 3 A 14 0 14
2 3 B 9 0 9
3 4 C 24 14 38
4 5 D 22 38 60
5 6 E 26 60 86
5 7 F 23 60 83
6 8 G 26 86 112
7 9 H 6 83 89
7 10 I 7 83 90
8 11 J 19 112 131
8 12 K 16 112 128
9 13 L 5 89 94
11 14 M 22 128 150
13 15 N 5 95 100
13 16 o 7 95 102
13 17 P 6 95 101
14 18 Q
R

Berikut untuk uraian perhitungan maju
adalah :
1. EF (1-3)=ES (1-3)+D

4. EF (4-5)=ES (4-5)+ D

ES3 = EF2=38
EF3 =ES3+D
—38+22 =60
5. EF (5-6)=ES (5-6) + D
ES4 = EF4=60
EF4  =ES3+D
— 60 +26 = 86
6. EF (5-7)=ES (5-7)+ D
ES5 = EF3=60
EFS =ES5+D
— 60 +23 =83
7. EF (6-8) =ES (6-8) + D
ES6 = EF4=86
EF6 =ES6+D
=86 +26=112

Hasil analisa hitung maju (Fordward Pass)
diperoleh waktu penyelesaian adalah 181 hari.
Adapun bentuk jaringan kerja analisa
hitungan maju dapat dilihat pada gambar 2
Dibawabh ini :

Gambar 2 Jaringan kerja analisa hitungan
maju

3.4.2 Analisa Hitung Mundur (Backward
Pass)

Setelah dilakukan perhitungan maju (forward
pass) untuk mengetahui waktu paling awal
aktivitas dimulai dan selesai, langkah
selanjutnya dalam metode CPM adalah
melakukan analisis hitungan mundur atau
backward pass. Perhitungan dimulai dari

ES1 = EF=0 aktivitas terakhir dalam jaringan kerja, dengan
EF1 =ESI+D nilai LF yang sama dengan EF hasil
=0+14=14 perhitungan forward pass (yakni 181 hari),
2. EF(2-3)=ES(2-3)+D kemudian dihitung mundur ke aktivitas-
ESI = EF=0 aktivitas sebelumnya sesuai hubungan
EF1 =ESI+D ketergantungan. Sebagai contoh :
=0+9=9 LS(i—-j)=EF(i-j)-D
3. EF(3-4)=ES(34)+D
ES2 =EF =14 Tabel 4 Hasil analisa Hitung Mundur
EF2 =ES2+D . Kegiata ~Waktu Paling
=14+24=38 Kegiatan (Har)  Awal
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; i Mul  Sele proyek tetap berada pada 181 hari, sesuai hasil
al sal dari  analisis maju sebelumnya. Ini
1 3 A 14 0 14 menandakan bahwa jaringan kerja dan
g i 2 294 154 ;g ketergantungan antar aktivitas sudah disusun
4 s D » 18 60 dengan tepat.
5 6 E 26 60 86
6 8 F 23 60 131
7 10 G 26 86 112
8 11 H 6 131 138
9 13 I 7 131 138
10 13 J 19 112 128
11 14 K 16 112 128
12 14 L 5 138 143
13 16 M 22 128 150
15 18 N 5 143 150
16 18 0 7 143 150 Gambar 3 Jaringan kerja analisa hitungan
17 18 P 6 143 150 mundur
14 18 Q 25 150 175
18 19 R 6 175 181 3.4.2 Menghitung waktu slack/float
Sumber : Hasil Penelitian (2025) Setelah dilakukan analisis forward pass dan
backward pass, langkah penting berikutnya
Berikut untuk uraian perhitungan maju dalam metode CPM adalah menghitung waktu
adalah: slack (float) untuk setiap aktivits. Slack atau
1. LS (19-18) =ES (19-18) -D float adalah selisih antara waktu paling lambat
LF17 = 181 dan waktu paling awal suatu aktivitas dapat
LF17 =LF17-D dimulai atau diselesaikan tanpa menyebabkan
=181-6=175 keterlambatan proyek secara keseluruhan.
2. LS (18-14)=ES (18-14) -D Slack dihitung menggunakan dua rumus
LFl6 =175 berikut :
LF16 = 1L7F51 62-5D 50 TS =LS - ES atau LF — EF
3. 1%1?1(518-17) :1132 (18-17) -D Tabel 5 Hasil analisa perhitungan total
= slack
LF15 =LF15-D . . Paling
—175-25 =150 Kegiatan i N Paling Awal Akhir ] Jalu
4.LS (18-16) = ES (18-16) -D Mmak Mul o Seles Mul o¢ ot T
LF14 = 175 i§ ) woai ai ai o gp oAl
LF14 =LF14-D ES - ED WS
=175-25=150 1 3 A 14 0 14 0 14 0 Ya
5. LS (18-15)=ES (13-15) -D g 431 2 294 1(11 398 154 ;g (5) TS;
LF13 =175 4 5 D 2 38 60 38 6 0 Ya
LF13 =LF13-D 5 6 E 2 60 86 60 8 0 Ya
=175-25=150 5 7 F 23 60 83 60 131 g Tdk
6. LS (16-13)=ES (16-13)-D 6 & G 26 8 112 8 112 0 Ya
LF12 = 150 7 9 H 6 8 89 131 138 g Tdk
LF12 =LF12-D 4
=150-7 =143 7 10 1 7 8 9 131 138 ¢ Tdk
7. LS (14—12)=ES (14_12) -D 8 11 J 19 112 131 112 128 0  Tdk
LFL1 150 8 12 K 16 112 128 112 128 2 Ya
LF11 —LF11-D 9 13 L 5 8 95 138 143 ¢ Tdk
=150-22 =128 11 14 M 22 128 150 128 150 0 Ya
Hasil dari analisis backward pass ini 1315 N 5 95 100 143 150 (5) Tdk
menunjukan bahwa waktu penyelesaian 3 16 O 7 95 102 143 150 g Tdk
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13 17 P 6 95 101 143 150

14 18 Q 25 150 175 150 175
18 19 R 6 175 181 175 181

Tdk pengalihan tenaga kerja, atau penanganan
va Tisiko tak terduka.

Sumber : Hasil Penelitian (2025)

Berikut untuk uraian perhitungan Total Slack
adalah :
1. TS(1-3) =LF (1-3)

TSI =14-14
=0
2. TS (2-3) =LF (2-3)
TSI  =14-9
=5
3. TS (3-4) =LF (3-4)
TSI  =38-38
=0
4. TS (4-5) =LF (4-5)
TSI  =60-60
=0
5. TS (5-6) =LF (5-6)
TSI  =86-86
=0
6. TS (5-7) =LF (5-7)
TSI  =131-83
=48
7. TS (6-8) =LF (6-8)
TSI  =112-112
=0

Dari hasil perhitungan di atas, diperoleh
bahwa aktivitas-aktivitas dengan total slack=0
merupakan aktivitas jalur kritis, yang berarti
aktivitas tersebut harus laksanakan tepat
waktu tanpa toleransi keterlambatan.

Adapun aktivitas yang termasuk dalam jalur
kritis aadalah :

A = Pekerjaan Persiapan

C = Pekerjaan Sub Struktur

D = Struktur Lantai 1

E = Struktur Lantai 2

G = Struktur Lantai 3

K = atap dan plafon

M = Pelapis lantai dan dinding

Q = Pengecatan

R = Data LAN, Acces Point, dan CCTV
Aktivitas-aktivitas ini harus diawasi secara
ketat karena keterlambatan satu hari pun akan
langsung mempengaruhi waktu penyelesaian
proyek secara keseluruhan.

Sebaliknya aktivitas non-kritis  seperti
plumbing, sistem elektrikal, dan fire alarm
memiliki  slack yang cukup besar,
memberikan fleksibilitas waktu yang dapat
dimanfaatkan untuk penyesuaian jadwal,

Gambar 4. Jalur Kritis

3.5. Analisis Microsoft Project

Setelah.  dilakukan analisis penjadwalan
proyek secara manual menggunakan metode
CPM, langkah selanjutnya adalah melakukan
simulasi dan visualisasi  penjadwalan
menggunakan perangkat lunak Microsoft
Project. Perangkat lunak ini sangat membantu
dalam ~ menyusun jadwal proyek yang
kompleks, karena mampu menampilkan
urutan kegiatan, durasi, dan hubungan antar
aktivitas dalam bentuk visual yang interaktif
dan mudah dipahami.

Pada proyek pembangunan Gedung Fakultas
Keguruan dan Ilmu Pendidikan Universitas
Siliwangi, data penjadwalan yang telah
dianalisis sebelumnya diinput ke dalam
Microsoft Project untuk menguji konsistensi
jalur kritis, serta memperoleh output berupa
Gantt Chart, Network Diagram, dan
identifikasi otomatis jalur kritis.

3.5.1 Membuat Network Planning dan
menentukan Lintasan Kritis

1. Membuat lembar kerja

Untuk membuat file project baru, Klik Start >
Microsoftr Project > Blank Project,
sehingga akan tampil lembar kerja kosong
seperti yang ditunjukan pada gambar 5
Dibawabh ini :

Gambar 5 Lembar kerja Microsoft Project
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3. Memasukan tanggal mulai kerja

Setelah membuka lembar kerja, masukan
tanggal mulai kerja klik menu project >
project information, sehingga akan muncul
jendela project information seperti yang
ditunjukan pada gambar 6 Pada menu tersebut
terdiri dari project start date dan project finish
date. Pada project ini tanggal mulai yang
dimasukan adalah 06 mei 2024.

Gambar 6 Menu project information

4. Mengatur penjadwalan dan kalender

Untuk mengatur penjadwalan dan kalender
kerja, klik Project > Change Working Time >
Work Weeks > Details. Pada menu ini dapat
mengatur durasi jam kerja per hari, durasi
kerja per minggu dan hari libur khusus.

Dalam Penjadwalan Proyek ini, durasi kerja
ditetapkan selama 8 jam per hari. Hari kerja
berlangsung dari senin hingga minggu,
dengan hari libur khusus pada hari raya
idulfitri dan hari raya kemerdekaan, 17
agustus 2024. Seperti yang ditujukan pada
gambar 7 dibawah ini: S
[

e

Gambar 7 Menu untuk change working time
5. Memasukan daftar kegiatan dan durasi
Langkah berikutnya adalah menginput
seluruh kegiatan ke dalam kolom task name
dan durasi pekerjaan ke kolom Duration. Saat
data diinput, Microsoft Project akan secara
otomatis menghitung dan menampilkan
tanggal mulai dan selesai pada kolom start dan
finish.

Gambar 8 Kolom Task Name
6. Menentukan hubungan antar aktivitas
Setiap kegiatan dihubungkan dengan kegiatan
sebelumnya sesuai urutan logis yang telah
ditentukan pada analisis manual. Hubungan
ini dimasukan melalui kolom Predecessor,
menggunakan sistem numerik yang
merepresentasikan urutan kegiatan
7. Visualisasi Gantt Chart Otomatis
Setelah semua data dimasukan dan hubungan
antar kegiatan ditentukan, Gantt Chart akan
muncul secara otomatis di sisi kanan lembar
kerja. Untuk menampilkan jalur kritis, cukup
mengaktifkan fitur Critical Tasks. melalui
menu Gantt Chart Tools > Format > Critical
Tasks. Setelah diaktitkan, Microsoft project
akan menyorot aktivitas kritis dengan warna
merah, sementara aktivitas non-kritis akan
berwarna biru. Seperti yang ditujukan pada
gambar 9 dibawah ini :

Gambar 9 Hasil Gantt Chart
Gambar tersebut merupakan tampilan Gantt
Chart dari perangkat lunak Microsoft Project
yang digunakan untuk penjadwalan proyek
kontruksi. Gantt chart menampilkan daftar
kegiatan proyek di sebelah kiri dan
representasi visual dari jadwal proyek di
sebelah kanan.

1. Bagian Kiri (Tabel Tugas)

- Task Mode : Menunjukan bahwa semua
tugas dijadwalkan secara manual (ikon
pensil biru)

- Task Name : Nama-nama pekerjaan
proyek, seperti pekerjaan persiapan,
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pengadaan dan persiapan aspek
keselamatan, pekerjaan sub struktur, dan
seterunya hingga pekerjaan data LAN,
access point dan CCTV.

- Duration : Durasi waktu pengerjaan
masing-masing tugas dalam satuan hari
kerja

- Start-Finish : Tanggal mulai dan selesai
untuk masing-masing pekerjaan

- Presecessors : menunjukan urutan
ketergantungan antar tugas,
menggunakan format Finish to Start
(FS) atau dengan waktu jeda.

2. Bagian Kanan (Gantt Chart)

- Merupakan visualisasi dari jadwal
proyek

- QGaris-garis horizontal berwarna merah
menunjukan jalur kritis (Critical Path)
yaitu tugas-tugas yang tidak memiliki
kelonggaran waktu (float) dan
menentukan durasi total proyek.

- Garis biru menunjukan aktivitas non-
kritis yang memiliki slack

- Panah antar tugas menunjukan
hubungan ketergantungan antar
pekerjaan

- Tanggal di bagian atas menunjukan
kalender proyek, mulai dari 06 mei 2024
hingga 11 November 2024

3.6.Pembahasan

Metode Critical Path Method (CPM)
digunakan sebagai pendekatan manual untuk
menganalisis penjadwalan proyek
berdasarkan durasi, urutan, dan
ketergantungan antar aktivitas. Dalam
penerapannya pada proyek pembangunan
Gedung FKIP Universitas Siliwangi. CPM
membantu mengidentifikasi waktu paling
awal dan paling akhir setiap aktivitas dapat
dimulai dan diselesainkan. Hasil perhitungan
fordward pass dan backward pass menunjukan
bahwa durasi total proyek berdasarkan metode
ini adalah 181 hari kalender, dengan jalur
kritis yang terdiri dari 9 aktivitas utama, yakni
A,C,D,E,G.K,M,Q, dan R.

Seluruh ativitas dalam jalur kritis tersebut
memiliki nilai slack = 0, yang berarti tidak
terdapat  kelonggaran waktu  untuk
keterlambatan. Keterlambatan satu hari saja

pada salah satu aktivitas kritis akan
berdampak langsung pada keterlambatan
proyek secara keseluruhan. Di sisi lain,
aktivitas  non-kritis  seperti  pekerjaan
plumbing, elektrikal dan fire alarm memiliki
slack yang cukup besar, sehingga memberi
fleksibilitas bagi pelaksana proyek dalam
menyusun strategi pelaksanaan. Analisis ini
menjadi  dasar penting bagi manajemen
proyek dalam mengelola waktu dan sumber
daya secara efisien

Sementara itu, penjadwalan proyek juga
dilakukan menggunkan perangkat lunak
Microsoft project untuk membandingkan dan
memverifikasi hasil dari metode CPM
manual.  Microsoft project memberikan
keunggulan dari sisi otomatisasi dan
visualisasi, seperti Gantt chart dan Network
diagram yang tersusun secara instan
berdasarkan input aktivitas, durasi, dan
hubungan ketergantungan. Selain tu, fitur
Critical Task mempermudah identifikasi jalur
kritis, yang secara struktur aktivitasnya
menunjukan hasil serupa dengan metode
manual.

Namun demikian, terdapat perbedaan durasi
total proyek antara hasil CPM manual dan
Microsoft  project. Berdasarkan output
Microsoft project, durasi proyek tercatat 185
hari kalender, atau 4 hari lebih Ilama
dibandingkan hasil perhitungan CPM sebesar
181 hari. Perbedaan ini diduga muncul karena
pengaruh pengaturan

kalender kerja dalam Microsoft project,
termasuk hari libur nasional (seperti idulfitri
dan 17 agustus) serta ketepatan pembulatan
waktu pelaksanaan pada aktivitas yang
berdekatan. Microsoft project secara otomatis
memperhitungkan  working time yang
realistis, sehingga durasi proyek dapat sedikit
bergeser dibandingkan pendekatan
perhitungan manual yang lebih ideal
Perbandingan  antara  kedua  metode
menunjukan bahwa meskipun struktur jalur
kritis tetap konsisten. Perbedaan kecil dalam
durasi total proyek menggaris bawahi
pentingnya memperhatikan detail pengaturan
kalender kerja dan jadwal pelaksanaan ketika
menggunakan perangkat lunak penjadwalan.
Metode CPM manual unggul dalam
memberikan pemahaman konseptual
mendalam terhadap logika penjadwalan,
sementara Microsoft project ungggul dalam
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efisiensi, otomatisasi, dan penerapan praktis
di lapangan. Oleh karena itu, penggunaan
kedua pendekatan ini secara komplementer
akan memberikan hasil perencanaan waktu
yang lebih optimal dan akurat untuk
manajment proyek kontruksi.

IV. SIMPULAN

Berdasarkan hasil analisis penjadwalan
proyek  pembangunan  Gedung  FKIP
Universitas Siliwangi menggunakan metode
Critical Path Method (CPM) dan perangkat
lunak Microsoft Project, menunjukan bahwa
durasi  waktu yang didapatkan _pada
penjadwalan proyek menggunakan metode
CPM pada Proyek pembangunan Gedung
FKIP Universitas Siliwangi adalah 181 hari
kerja dengan perbandingan waktu adalah 245
hari kerja, dimana proyek dimulai dari 06
Maret 2024 hingga 11 November 2024. Yang
dimana proyek dapat diselesaikan lebih cepat
64 hari dari waktu pelaksanaan kontrak.
Dengan 9 aktivitas utama yang berada dalam
jalur kritis (aktivitas A, C, D, E, G, K, M, Q,
dan R). Aktivitas-aktivitas ini memiliki nilai
slack = 0, sehingga tidak memiliki toleransi
keterlambatan dan memerlukan pengawasan
ketat.

Perhitungan manual CPM juga
mengidentifikasi aktivitas non-kritis yang
memiliki waktu slack cukup besar (hingga 50
hari), yang dapat dimanfaatkan untuk
pengaturan jadwal ulang atau mengintisipasi
risiko keterlambatan. Hasil ini membuktikan
bahwa metode cpm efektif dalam memberikan
pemahaman mendalam terhadap struktur
ketergantungan dan prioritas aktivitas dalam
proyek.

Penjadwalan proyek menggunakan Microsoft
Project memberikan hasil yang relative serupa
dalam hal urutan kegiatan dan identifikasi
jalur kritis. Namun, terdapat selisih durasi
total proyek menjadi 185 hari kalender, atau
lebih lama 4 hari dibandingkan metode CPM.
Hal ini disebabkan oleh pengaturan kalender
kerja dan waktu libur khusus yang
dipertimbangkan secara otomatis oleh
prangkat lunak.
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